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PHYSICAL DEVICE RASPBERRY PI
The Raspberry Pi Computer:

e It may not look much like the computers you are used to, but this is because
we are accustomed to seeing a computer in a case, with a monitor, keyboard
and mouse attached.

e The Raspberry Pi comes without any of these peripheral input, output and
storage devices. It is known as a single board computer, and the fact that it
comes without any additional peripherals, and uses hardware components
more usually found in mobile phones and tablets, means it can be sold for as

little as $35.

e The Raspberry Pi has several ports that enable you to connect a variety of
devices.

e Input devices let you send data to a computer. The two most common input
devicesare a keyboard and a mouse. You can plug a USB keyboard and mouse
into two of the four USB ports on the Raspberry Pi.

e Output devices let the computer send data to a user. Two of the most common
output devices are a monitor and speakers. You can connect an HDMI monitor
or television to the Raspberry Pi using the single HDMI port. If you don’t have an
HDMImonitor,then you’ll need to use an adaptor. You can connect speakers or
headphones to the Raspberry Pi using the 3.5mm headphone port.

e Storage devices are used to store data. On most computers this would be
handled bya hard drive. Most modern computers, tablets and mobile phones
now use Solid State

storage devices. The Raspberry Pi uses a type of Solid State storage device
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called a microSD card. This will be used to store the Operating System, your
software, and all the files you create.

e Thelastthingyou’llneedtodois provide your Raspberry Piwith power. Forthis, we use
a micro-USB power supply.

RASPBERRY PI INTERFACES

e There are many peripherals that can be added to a microprocessor over the 12C
and SPI serial interfaces. These include atmospheric sensors, EEPROMS, and
several types of display.

The Pi Wedge helps access the 12C and SPI signals.

e This tutorial will walk you through getting the 12C and SPI interfaces of your
Raspberry Pi working. These interfaces aren't enabled by default, and need
some extra configuration before you can use them.

Background & Software Setup

e The Raspberry Pi has three types of serial interface on the GPIO header. You're
probably already familiar with the UART serial port, which allows you to open a
login session from a serial terminal application, such as PuTTY.

e The other two serial interfaces are the Serial Peripheral Interface (SPI) and Inter-
Integrated-Circuit bus (12C). SPI on the Pi allows for up to two attached
devices, while [2C potentially allows for many devices, as long as their
addresses don'tconflict.
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Software Details

e The software landscape for the Raspberry Pi has evolved considerably since the
introduction of the Pi. Many different operating systems have been ported to the
Pi, and the device driver infrastructure has also changed quite a bit.

e For this tutorial, we'll be using a recent version of Raspbian (installed via
NOOBS), and the wiringPi I/O library for C/C++ (or spidev/smbus for Python).

e With the implementation of device tree overlays in Raspbian, some of the specific
interface enablement details have changed. If you're working with an older install,
it might be worth backing up your SD card, and starting with a fresh install.

Connecting To the Ports

e Before we getinto the configuration and software examples, let’s locate the pins used
by each of these interfaces.

e If you're directly connecting to the pins on the Pi, they're a little disorganized.
I2C.1 is near one end, while SPI and 12C.0 are in the middle of the header. If
you're connecting to these pins, be sure to count carefully.

Fin 19-SF1 MOST———> BB
Pin 21<8PI MISC ——> LR
Pin 23-SPI SCLK~——9 N
Pin 27-12C.8 SDA~—oEIEH

F ‘.l‘-ulnlr"l-n

Pi Serial Bus Pins

e The Pi Wedge adapter PCB rearranges the pins, and labels them clearly. We'll
be using the Wedge for the following examples.
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T2C.1.:SCL

/I2C. 1 SDA

I2C.0 SCL
I2C.0 SDA

Wedge Serial Bus Pins

SPIl on Pi connfiguration

e The SPI peripheral is not turned on by default. There are two methods to
adjustthe settings. To enable it, do the following.

e Raspberry Pi Configuration via Desktop GUI

e You can use the Desktop GUI by heading to the Pi Start Menu > Preferences >
Raspberry Pi Configuration.

e

CC TN
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e A window will pop up with different tabs to adjust settings. What we are interested
is the Interfaces tab. Click on the tab and select Enable for SPI. At this point, you
can enable additional interfaces depending on your project needs. Click on the
OK button to same.

e We recommend restarting your Pi to ensure that the changes to take effect. Click
on the Pi Start Menu > Preferences > Shutdown. Since we just need to restart,
click on the Restart button.

Shutdown Turn Off Restart, L og Off

raspi-config Tool
e If you are using a terminal, you will need to:
1. Run sudo raspi-config.
2. Use the down arrow to select 5 Interfacing Options

3. Arrow down to P4 SPI.
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Select yes when it asks you to enable SPI,
Also select yes if it asks about automatically loading the kernel module.

Use the right arrow to select the <Finish> button.

N oo o A

Select yes when it asks to reboot.

B pi@raspberrypi: ~ — O .

~
Raspberry Pi Software Configuration Tool (raspi-config)

Pl Camera Enable/Disable connection to the
P2 55H Enable/Disable remote command lin
P3 VHC Enable/Disable graphical remote a

e automatic loading

PS5 T2C automatic loading

P66 Serial Enable/Disable shell and kernel m

PT7 1-Wire Enable/Disable one-wire interface

P83 Remote GPIO Enable/Disable remote access to G
<Select> <Back>

_v

Raspi-config for SPI

e The system will reboot. When it comes back up, log in and enter the following
command

o >Is /dev/*spi*
e The Pi should respond with
o /dev/spidev0.0 /dev/spidev0.1

e These represent SPI devices on chip enable pins 0 and 1, respectively. These
pins are hardwired within the Pi. Ordinarily, this means the interface supports at
most two peripherals, but there are cases where multiple devices can be daisy-
chained, sharing a single chip enable signal.

Programming Example
e Required Materials

o The 40-pin Pi Wedge.
o A Raspberry Pi B+ or Pi 2 Model B single board computer.

o A Solderless Breadboard.

o Some jumper wires.
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o Headers of your choice.
o A Serial 7-Segment display.

e The Serial 7-Segment display is particularly useful for testing serial interfaces,
because it can accept command from a UART, SPI, or I2C. Make sure to solder
header pins on the 7-segment display before wiring.

Hookup Table

e The display was connected to the Pi, via the Pi Wedge, as follows.

Raspberry Pi Signal Serial 7-seg Signal
GND GND
3.3V VCC
CE1l SS (Shift Select)
SCK SCK
MOSI SDI
MISO SDO

e The test hardware looked like this.

~ ~ =0

Serial 7-Segment connections
for SPI
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Sample Python Program

# spitest.py

# A brief demonstration of the Raspberry Pi SPI interface, using
the Sparkfun # Pi Wedge breakout board and a SparkFun Serial 7
Segment display:

#

https://lwww.sparkfun.com/products/116

29 import time

import spidev

# We only have SPI bus 0 available to us on

the Pi bus =0

#Device is the chip select pin. Set to 0 or 1, depending on the
connections device =1

# Enable SPI

Spi = spidev.SpiDev()

# Open a connection to a specific bus and device (chip select pin)
spi.open(bus, device)

# Set SPI speed and

mode

spi.max_speed_hz =

500000

spi.mode =

0 # Clear

display msg

= [0x76]

spi.xfer2(ms

9)

time.sleep(5

)

# Turn on one segment of each character to show that
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we can # address all of the segments
i=1
while i < Ox7f:
# The decimals, colon and
apostrophe dots msg = [0x77]
msg.append(i)
result =
spi.xfer2(msg) #
The first character
msg = [0x7b]
msg.append(i)
result =
spi.xfer2(msg) #
The second
character msg =
[Ox7c]
msg.append(i)
result =
spi.xfer2(msgqg) #
The third character
msg = [0x7d]
msg.append(i)
result =
spi.xfer2(msgqg) #
The last character
msg = [0x7e]
msg.append(i)
result = spi.xfer2(msg)
# Increment to next segment in each

character i <<=1
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# Pause so we can see
them time.sleep(5)
# Clear display
again msg =
[0X76]
spi.xfer2(msg)
e Save the program with a name like spitest.py, and run it with:

o >python spitest.py

e This will illuminate each segment in each character for 5 seconds before

moving onto the next segment. It should take about 40 seconds for the whole
program to run.

12C on Pi
Configurati

on

e The I2C peripheral is not turned on by default. There are two methods to
adjust the settings just like the SPI. To enable it, do the following.

e Raspberry Pi Configuration via Desktop GUI

e You can use the Desktop GUI by heading to the Pi Start Menu > Preferences >
Raspberry Pi Configuration.

®19¢

¢ A window will pop up with different tabs to adjust settings. What we are interested
is the Interfaces tab. Click on the tab and select Enable for 12C. At this point, you
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can enable additional interfaces depending on your project needs. Click on the
OK button to same.

e Click on image for a closer view.

e \We recommend restartina valir Pi to ensiire that the channes to take effect Click
--‘-‘S > Shutd P ﬁ:...:: P [ S [ R RPN

—_—— 4l - M AL L AA_ .. . IN__C_
L
e

Shutdown Turn Off Restart, Log Off

raspi-config Tool

Like the SPI peripheral, 12C is not turned on by default. Again, we can use raspi-config
to enable it.

1. Run sudo raspi-config.

2. Use the down arrow to select 5 Interfacing Options
3. Arrow down to P5 I12C.
4

. Select yes when it asks you to enable 12C
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5. Also select yes if it asks about automatically loading the kernel module.
6. Use the right arrow to select the <Finish> button.

7. Select yes when it asks to reboot.

B pi@raspberrypi: ~ - O x
-
Raspberry Pi Software Configuration Tool (raspi-config)
Pl Camera Enable/Disable connection to the
P2 55H Enable/Disable remote command lin
P3 WVNC Enable/Disable graphical remote a
P4 S5PI Enable/Disable automatic loading
5 I2C ading
P6 Serial Enable/Disable shell and kernel m
PT 1-Wire Enable/Disable one-wire interface
P& Remote GPIO Enable/Disable remote access to G
<Select> <Back>

_V

Raspi-config for 12C

e The system will reboot. when it comes back up, log in and enter the following
command

o >Is /dev/*i2c*
e The Pi should respond with
o /dev/i2c-1
e Which represents the user-mode 12C interface.
e Utilities
e There is a set of command-line utility programs that can help get an 12C
interface working. You can get them with the apt package manager.
o sudo apt-get install -y i2c-tools

e In particular, the i2cdetect program will probe all the addresses on a bus, and
report whether any devices are present.

pi@raspberrypi:~/$ i2cdetect -
y10123456789ab
cde f

00: e R RS S e
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1

200 -- om e e e e e
B0: == == m e e e e e e e e e e e
70: == = == - o - -

e This map indicates that there is a peripheral at address 0x60. We can try to read

andwrite its registers using the i2cget, i2cset and i2cdump commands.

Programming Example

Required Materials

The 40-pin Pi Wedge.

A Raspberry Pi B+ or Pi 2 Model B single board computer.

A Solderless Breadboard.

Some jumper wires.

Header pins of your choice.

An MCP4725 digital-to-analog converter.

Hookup Table

The display was connected to the Pi, via the Pi Wedge, as follows.

Raspberry Pi MCP472
Signal 5
GND GND
3.3V VCC
SCL SCL
SDA SDA

The test hardware looked like this.
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Sample Python Program
#i2ctest.py
# A brief demonstration of the Raspberry Pi 12C interface, using the
Sparkfun # Pi Wedge breakout board and a SparkFun MCP4725
breakout board:
#
https://www.sparkfun.com/products/87
36 import smbus
#12C channel 1 is connected to the
GPIO pins channel =1
# MCP4725 defaults to address
0x60 address = 0x60
# Register addresses (with "normal mode" power-
down bits) reg_write_dac = 0x40
# Initialize 12C (SMBus)
bus = smbus.SMBus(channel)
# Create a sawtooth wave 16
times for i in range(0x10000):
# Create our 12-bit number representing relative

voltage voltage =i & Oxfff

Page 15



http://www.sparkfun.com/products/8736
http://www.sparkfun.com/products/8736

# Shift everything left by 4 bits and separate bytes

msg = (voltage & 0xff0)
>>4 msg = [msg, (Msg &
Oxf) << 4]
# Write out 12C command: address, reg_write_dac,
msg[0], msg[1] bus.write_i2c_block_data(address,
reg_write_dac, msg)
e Save the program with a name like i2ctest.py, and run it with the command:

o python
i2ctest.py APIS /
PACKAGES

e Wouldn'tit be interesting to have an API to control our hardware, like Arduino or
Raspberry Pi? We now have the tools to make this possible and easy.

e Having an API for our hardware allows us to remotely control and/or monitor
our hardware with code. With this power, we can even build apps on top of our
hardware!

e We'll walk through creating an API for the Raspberry Pi Zero W to control
four LEDs, each connected to its own GPIO. The same idea works for other
hardware too.

e First, we'll need to set up our Raspberry Pi Zero W. Unlike typical Pi setups,
we can do this without a monitor. If you need help with this, check out this
tutorial.

e To begin, we'll need to make sure our device is updated and the proper
libraries are installed.

Update and Install Libraries
e First, let's update our Pi:
o sudo apt-get upgrade && sudo apt-get update
e Next, install the libraries we need:

o sudo apt-get install git python-pip python-gpiozero python-pkg-
resources

Clone the Code

e Using Git, clone the code from GitHub:
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o git clone https://github.com/Losant/example-raspberry-pi-api.git
e Change to the new project directory:
o cd example-raspberry-pi-api

¢ In the folder, you'll see a file named "index.py". This is where the magic
happens.You can see the contents_of this file in the Code section.

e We still need to configure one line of the code before we can run:

o device = Device("my-device-id", "my-app-access-key","my-app-access-
secret")

e You can obtain the device ID, access key, and access secret from Losant.
Losant

e Losant is an easy-to-use and powerful developer platform designed to helpyou
quickly build connected applications.

1. Log in and create an application in Losant.
2. Create a device.

e In Losant, a device could be Raspberry Pi, Arduino, smart bulb,or any custom
hardware. Devices can contain many sensors or attached peripherals.

SO LOSANT Daskdoqrds -

EZ MY SANDBOX / RASBERAY P1 API / NEW DEVICE

Create a device in Losant
3. Create an Access Key and Secret.

e To connect your devices to the Losant Platform, you must use a set of
security credentials called access keys. Access keys consist of a generated
key and secretpair.
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4. Create a Losant Experience.

e Writing an API service, implementing the entire user authentication, and hosting
the result somewhere is a lot of work. An Experience in Losant brings all of this
functionality directly inside your Losant application.

e Experiences are the key to building fully functional API allowing users to interact
with our device.

LOSANT Dashboards ~ Applications = Organizations ~ ,z. Tacon -

YOUR APPLICATION'S EXPERIENCE

y o bekid cost you

weperieace makes |

e After creation, a lot happens. We created a Walkthrough Video that walks you
through the process and gives some background to what's going on.

Page 18



https://docs.losant.com/devices/overview/
https://www.youtube.com/watch?v=klcBw-Gd9wU&t=8s

5. Create an Endpoint

e An Endpoint is a combination of an HTTP method and a route that, when invoked
by an HTTP request, can fire a workflow. That workflow does some work, like
control an LED, and responds to the request.

71

e For this example, we're going to create a GET request to toggle a GPIO pin. If
the URL for this route would look something like this:

o https://example.onlosant.com/gpio/{number}
e The method and route, in this case, would be:
o GET /gpio/{number}

e "Number" in the route is a path parameter. We'll replace this with the GPIO we
want to toggle.

e You can configure this in Losant like so:
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s | New Endpoimt

© All pblic users

Only users who are in the following groups

ol | Cancel

e Note: Every endpoint has access control. To make things easy, our routes will
be public. However, you are able to add authentication to endpoints.

Create a Workflow for the new endpoint

e Every Endpoint is powered by a Workflow. If you go down to the bottom of the
endpoint configuration, you’ll see the option to create a workflow for that route.

e Then, you'll have a basic workflow:

et

=
e
L

-

S
v

e Every endpoint workflow will start with an Endpoint Trigger and end with an_
Endpoint Reply. The Endpoint Trigger is fired when you make an HTTP request.
The Endpoint
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Reply responds to the HTTP request. So, this workflow isn't doing anything but
responding immediately.

7. Update workflow to send device command.

e If you take a peek in the Python code, there is an "on_command" function
that's attached to an event.

o device.add_event_observer("command", on_command)

e We can trigger this function by sending a Device Command to our Pi. Drag-and-
Drop the Device Command node:

¢ In the code, we are also listening for a command called "gpioControl" and
looking for a payload variable called "gpio".

e Select the Device Command node to configure it.
o Command Name Template: gpioControl
o Command Payload Type: JSON Template
o Command Payload JSON Template:
o {"gpio" :"{{ data.params.number}}" }

Wiring
¢ Now, you should wire the Raspberry Pi to the four 4 LEDs. This wiring
diagram is supplied in the Wiring section.

e We'll connect the LEDs to 6, 13, 19, and 26.
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Testing
e That's it! Now you are ready to test.
e To start your code:
o python index.py
e To trigger an API request, we can use an app called Postman.
e Enter your URL and send the request:

| e

e Once you fire the request, use 6, 13, 19, or 26 as the parameter and watch that
LED lightup!

WEB SERVICES

Various web servers are available, with different advantages for usage:
1. Apache
2. NGINX

1. Apache

e Apache is a popular web server application you can install on the Raspberry Pito
allow it to serve web pages.

¢ On its own, Apache can serve HTML files over HTTP, and with additional

modulescan serve dynamic web pages using scripting languages such as
PHP.

Install Apache

e First, update the available packages by typing the following command into the
Terminal:

o sudo apt update
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e Then, install the apache2 package with this command:

o sudo apt install apache2 -y

Test the web server

e By default, Apache puts a test HTML file in the web folder. This default web page
is served when you browse to http://localhost/ on the Pi
itself, or http:/192.168.1.10 (whatever the Pi's IP address is) from another
computer on the network. To find the Pi's IP address, type hostname -l at the
command line (or read more about finding your IP address).

e Browse to the default web page either on the Pi or from another computer on the
network and you should see the following:

O Apache2 Debian Default Page

Tren Is the default welcome page usad to test the cormect operation of the Apache2 secyer after
Inctafation on Debian systems. If you can read thas page, it means that the Apache HTTP servers
Instalied ot this site Is working peoperty, You should replace this file (located at /var /v

/el Jindex . hiel) before cantinuang 1o OPeraty your HITP server

If you ore o cormsl yser of they wed site god don't know what thus page 15 about, thes probebily measns

that the site & currerzly unavadable due 1o maintenance. i the problem persists, please contact the
site's adrirsstrator

” TN ra\-?\\ B P U
e ——— —__GUNRGNIFOROR LR VIS W }——v« P _
Debian's ApacheZ defaull configuration Is different from the upstream Sefaull coofiguration, snd spit Into

several Nles optimized for teraction with Dedian tools, The configuration system i fully documemed
in /ust/share/doc/apache2/README, Deblan.gz. Refer to this for the full documentation
Docuimertation for the web server itsel can be found by acoessing the manual if the apache -doc
package was instalied on this server

The configuratian layout for an Apachel web server rstalistion on Deban systems 1S a8 follows

fetc/apache2s
|-~ apache2.conf
ports.cont
mnods-enabled
| +. load
*.conf
conf-enabled
| *.conf
|+~ xites-ennbled
* . conf

e This means you have Apache working!
Changing the default web page
e This default web page is just an HTML file on the file system. It is located at
o [Ivar/www/html/index.html.
e Navigate to this directory in a terminal window and have a look at what'sinside:
o cd ivar/www/html
o Is -al
This will show you:
o total 12
o drwxr-xr-x 2 root root 4096 Jan 8 01:29.
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o drwxr-xr-x 12 root root 4096 Jan 8 01:28 ..
o -rw-r--r-- 1 root root 177 Jan 8 01:29 index.html

e This shows that by default there is one file in /var/iwww/html/ called index.htmland
it is owned by the root user (as is the enclosing folder). In order to edit the file,
you need to change its ownership to your own username. Change the owner of
the file (the default pi user is assumed here) using sudo chown pi: index.html.

e You can now try editing this file and then refreshing the browser to see the web
page change.

Your own website

o If you know HTML you can put your own HTML files and other assets in this
directory and serve them as a website on your local network.

Additional - install PHP

e To allow your Apache server to process PHP files, you'll need to install the latest
version of PHP and the PHP module for Apache. Type the following command to
install these:

o sudo aptinstall php libapache2-mod-php -y
e Now remove the index.html file:

o sudo rmindex.html
e and create the file index.php:

o sudo nano index.php
e Put some PHP content in it:

o <?php echo "hello world"; ?>

¢ Now save and refresh your browser. You should see "hello world". This is not
dynamic but still served by PHP. Try something dynamic:

o <?php echo date('Y-m-d H:i:s"); ?>
e or show your PHP info:
o <?php phpinfo(); ?>
2. NGINX

¢ NGINX (pronounced engine Xx) is a popular lightweight web server application
you can install on the Raspberry Pi to allow it to serve web pages.
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e Like Apache, NGINX can serve HTML files over HTTP, and with additional
modules can serve dynamic web pages using scripting languages such as
PHP.

Refresh database of available packages

e Ensure that the package manager has up-to-date information about which
packages are available:

o sudo apt update

e You only need to do this occasionally, but it's the most likely solution if
subsequent steps fail with messages like:

o 404 Not Found [IP: 93.93.128.193 80]
Install NGINX
e First install the nginx package by typing the following command in to the Terminal:
o sudo apt install nginx
e and start the server with:
o sudo /etc/init.d/nginx start
Test the web server

e By default, NGINX puts a test HTML file in the web folder. This default web page
is served when you browse to http://localhost/ on the Pi
itself, or http://192.168.1.10 (whatever the Pi's IP address is) from another
computer on the network. To find the Pi's IP address, type hostname -I at the
command line (or read more about finding your IP address).

e Browse to the default web page either on the Pi or from another computer on the
network and you should see the following:

I! [1 192.168.1.50

Welcome to nginx!

Changing the default web page

e NGINX defaults its web page location to /var/www/html on Raspbian. Navigate to
this folder and edit or replace index.nginx-debian.html as you like. You can
confirm the default page location at /etc/nginx/sites-available on the line which
starts with 'root’, should you need to.
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Additional - Install PHP
sudo apt install php-fpm

e Enable PHP in NGINX
cd /etc/nginx
sudo nano sites-enabled/default

e find the line
index index.html index.htm;

e roughly around line 25 (Press CTRL + C in nano to see the current linenumber)

e Add index.php after index to look like this:
index index.php index.html index.htm;

e Scroll down until you find a section with the following content:
# pass the PHP scripts to FastCGl server listening on
127.0.0.1:9000 #

# location ~ \.php$ {

e Edit by removing the # characters on the following lines:
location ~\.php$ {
include snippets/fastcgi-php.conf;
fastcgi_pass unix:/var/run/php5-
fpm.sock;

}

e It should look like this:

# pass the PHP scripts to FastCGl server listening on
127.0.0.1:9000 #

location ~\.php$ {

include snippets/fastcgi-php.conf;

# With php-fpm (or other unix sockets):

fastcgi_pass unix:/var/run/php/php7.0-

fpm.sock; # With php-cgi (or other tcp

sockets):

# fastcgi_pass 127.0.0.1:9000;
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}

e Reload the configuration file
sudo /etc/init.d/nginx reload
e TestPHP
e Rename index.nginx-debian.html to index.php:
cd /var/www/html/
sudo mv index.nginx-debian.html index.php
e Open index.php with a text editor:
sudo nano index.php
e Add some dynamic PHP content by replacing the current content:

<?php echo phpinfo(); 2>

Save and refresh your browser. You should see a page with the PHP version,
logo and current configuration settings.

INTEL® GALILEO GEN2 WITH ARDUINO

Page 27




e 1 - -
. LA A L]

5
S0eNNENS RRSORRREES LR
N .

4

sSesaen o.nnooo,'-‘!”'v;;nn L MMM L]
» J L CALLLL B Y

. i |

Overview

e Thelntel®GalileoGen2isaboardbasedonthe Intel®Quark™ SoCX1000,a32-bit
Intel® Pentium® processor-class system on a chip (SoC), operating at speeds up
to 400MHz.

e The Quark processor supports the Yocto 1.4 Poky Linux distribution.

e The board has built-in Ethernet with support for Power Over Ethernet(PoE), a
USB 2.0 Host Port, micrso-SD slot, PCI Express mini-card slot, 20 digital
input/output pins (of which 6 can be used as PWM outputs with 8/12-bits of
resolution and 6 as analog inputs with 12 bits of resolution), a micro USB
connection, an ICSP header, a JTAG header, and 2 reset buttons.

e Thereisalso anintegrated Real Time Clock (RTC), with an optional 3V “coin cell” battery
for operation between turn on cycles.

e The Intel® Galileo Gen2 supports shields that operate at either 3.3v or 5v. The
board is designed to be hardware and software pin-compatible with Arduino
shields designed for the Uno R3. Digital pins 0 to 13 (and the adjacent AREF and
GND pins), Analog inputs 0 to 5, the power header, ICSP header, and the UART
port pins (0 and 1), are all in the same locations as on the Arduino Uno R3.
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Supported Arduino libraries

The software release supports the following Arduino libraries:

e SPI

e EEPROM
o UART

e GPIO

e Wi-Fi

e Servo

e USB Host

Microcontroller SoC Quark X1000

Operating 3.3V /5V
Voltage
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Input Voltage 7-15V

Digital I/0 Pins | 14 (of which 6 provide 8/12-bit PWM
output)

Analog Input 6
Pins

Flash Memory 512 kB

RAM 256 MB DDR3

SRAM 512 kB

Flash Storage 8MB

EEPROM 8kB

Clock Speed 400 MHz

PoE compatible | -

Length 124 mm

Width 72 mm

Differences between the Intel® Galileo Gen2 and the Intel® Galileo

e The earlier Intel Galileo did not have an on-board regulator, so the power supply
had to be exactly 5V. The Intel Galileo Gen2 has on-board regulator, so it may be
powered with any suitable supply providing 7-15 VDC.

Differences between the Arduino Yun and the Intel® Galileo Gen2

e The Arduino Yun has two processors: One runs Linux, and an Atmel
microcontroller runs the Arduino sketch. The Intel® Galileo Gen2 has one
processor. In addition to running Linux, this processor runs the Arduino sketch.

Differences between the Intel® Galileo Gen2 and all Arduinos

e Note that a sketch loaded into the Intel® Galileo Genz2 is lost after a power cycle.
It is possible to boot the Intel® Galileo Gen2 from a USD card, and in that case to
restore a sketch from the same card. Instructions for doing so are forthcoming.
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On-board Linux

e The Yocto 1.4 Poky Linux distribution is installed on your Intel Galileo Gen2.
You can access various Linux functions with the system() call.

Power

e The Intel® Galileo Gen2 can be powered only via an external power supply. The
adapter can be connected by plugging a 2.1mm center-positive plug into the
board's power jack. The board can operate on an external supply of 7 to 15 volts.
The provided power supply provides 12v.

The power pins are as follows:

e VIN: The input voltage to the Intel® board. You can access the voltage supplied
via the power jack through this pin.

e 5V: This pin outputs a regulated 5V from the regulator on the board.

e 3.3V: A 3.3 volt supply generated by the on-board regulator. This regulator also
provides the power supply to the Quark microcontroller.

e GND: Ground pins.

e |OREF: This pin on the Arduino board provides the voltage reference with which
the microcontroller operates. This can be 3.3V or 5V based on the IOREF jumper
position.

e 12V power-over-Ethernet (PoE) capable
Buttons
There are 2 reset buttons with different functions on the board:
e Reboot: resets the Quark X1000 processor
e Reset: resets sketch and any attached shield
Memory
e The Quark X1000 has 512kB of embedded SRAM.

e The board has an additional 256 MB DDR3 Ram amd 8MB of Flash to store
firmware and the Arduino sketch. It's possible to update the firmware using the
IDE. The on board uSD supports uSD card up 32G, and can be used to provide a
complete Yocto 1.4 Poky Linux image.

Input and Output
e Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data.
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e Digital I/O: Digital pins 0 through 13 and Analog pins A0 through A5 can be used
as a digital input or output, using pinMode(), digitalWrite(), and digitalRead()
functions. They can operate at 3.3 or 5 volts.

Each pin can provide (source) or receive (sink) a current of 16mA @ 5v, or a current of
8MA@3.3V

e PWM: Pins 3,5,6,9,10, and 11

o Provide 8/12bit PWM output with the analogWrite() function. The resolution
of the PWM can be changed with the analogWriteResolution() function.

e SPI: SPI header (ICSP header on other Arduino boards)
o These pins support SPI communication using the SPI library.
e Analog Inputs: pins AO through A5

o Each analog input provide 10/12 bits of resolution. The resolution can be
changed with the analogReadResolution() function.

e SDA and SCL: Support TWI communication using the Wire
library. There are 2 reset buttons with different functions on the

board:
e Reboot:

o resets the Quark X1000 processor

e Reset:

o resets sketch and attached shield
Communication

e The Intel® Galileo Gen2 has a number of facilities for communicating with a
computer, another Galileo, Arduino or other microcontrollers, and different
devices like phones, tablets, cameras and so on.

e It provides 2 UART Controllers : UART 0 to Galileo headers 0, 1; UART 1 to 6-pin
3.3V USB TTL FTDI header; optionally directed to Galileo headers 2, 3.

e The Native USB port can also act as a USB host for connected peripherals such
as mice, keyboards, and smart phones. To use these features, see the USB Host
reference pages. The onboard microSD card reader is accessible through the SD
Library. The communication between Galileo and the SD card is provided by an
integrated SD controller and does not require the use of the SPI interface like
other Arduinoboards.
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The onboard Ethernet interface is fully supported, use the Ethernet Library. It
does not require the use of the SPI interface like existing Arduino shields.

The Arduino software includes a Wire library to simplify use of the TWI/I2C bus;
see the documentation for details. For SPI communication uses the SPl library.

The board provides also a mini PCI Express (mPCle) slot. This slot allows full
size and half size (with adapter) mPCle modules to be connected to the board
and also provides an additional USB Host port via the slot. Any standard mPCle
module can be connected and used to provide applications such as WiFi,
Bluetooth or Cellular connectivity.

Programming

The Intel® Galileo Gen2 can be programmed with this special version of the
Arduino software. It's possible to make requests of the Linux kernel with system()
calls. This gives your Arduino sketch access to powerful utilities like Python,
Node.js, OpenCV, and all sorts of fun Linux stuff.

Note that Intel® Galileo Gen2 forgets the sketch after powering down. It is
possible to booth the Galileo Gen2 from the uSD card, and in that case, to
restore a sketch from the same card. Instructions for that will be forthcoming.

ARDUINO INTERFACES
GPS Module Interfacing With Arduino UNO

Interfaced GPS receiver module with Arduino UNO and display the Time,
Latitude, Longitude, and Altitude info on the Serial window. Arduino read the data
serially from GPS receiver using USART communication with 9600 Baud rate.
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HC-05 Bluetooth Module Interfacing With Arduino UNO

e Bluetooth is a wireless communication protocol used to communicate over short
distances. HC-05 Bluetooth module uses serial communication to talk with
microcontrollers.

Analog Joystick Interfacing With Arduino UNO

e Analog Joystick is an input device used to control the pointer
movement in 2- Dimensional axes. Generally, joystick is used for
getting angular movements.
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LM35 Interfacing With Arduino UNO

e LM35 is a sensor which is used to measure temperature. It provides an electrical
output proportional to the temperature (in Celsius).

4x4 Keypad Interfacing With Arduino UNO

e Keypad is an input device which is generally used in applications such as
calculators, ATM machines, computers etc.
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ADXL335 Accelerometer Interfacing With Arduino Uno

X

Y Z

e ADXL335 accelerometer sensor measures acceleration due to gravity. It is used
to measure the angle of tilt or inclination in application systems such as in Mobile
devices, Gaming applications, Laptops, Digital cameras, Airplanes etc.

MT8870 DTMF Decoder Interfacing With Arduino UNO

e MT8870 is a DTMF (Dual Tone Multi-Frequency) receiver, which decodes the
dial tone generated from a telephone keypad. It used in Interactive Voice
Response Systems (IVRS), Remote control, Credit card systems etc.
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IR Communication Using Arduino UNO

\l/

e IR (infrared) communication is a wireless communication technology, used for
short distance data/control transmission. It is commonly used in TV remotes,
mobile phones, computers, and PDAs etc.

Magnetometer HMC5883L Interfacing With Arduino UNO

HMC5883L is a triple axis magnetometer developed by Honeywell. It provides the
direction of heading. Magnetometer is used as a compass in Mobiles Phones and
Navigation systems in vehicles to indicate directions.
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PIR Sensor Interfacing With Arduino UNO

¢ PIR motion sensor senses Infrared signals. It is generally used to detect the
motion of humans or animals.

MPUG050 Interfacing with Arduino UNO

e MPUG050 sensor module is a combination of 3-axis Gyroscope, 3-axis
Accelerometer and Temperature sensor with on-board Digital Motion Processor
(DMP). 1t is used in mobile devices, motion enabled games, 3D mice, gesture
(motion command) control technology etc.
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DHT11 Sensor Interfacing With Arduino UNO

e Interface single wire DHT11 sensor with Arduino Uno to read the values of
Temperature and Humidity. Display these Temperature and Humidity values on
a serialwindow.

DC Motor Interfacing With Arduino UNO

e DC Motor is a device which converts electrical energy into mechanical energy. It
is used in robotics field, toys, quad copters etc.
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DS1307 RTC Module Interfacing With Arduino UNO

e DS1307 is a two wire (12C) serial interface RTC (Real Time Clock) with 56 byte
of nonvolatile RAM. This provides clock and calendar with second, minute, hour,
day, date, month and year.

LCD 16x2 Interfacing With Arduino Uno

e LCD16x2 has two lines with 16 characters in each line. LCD16x2 is
generally usedfor printing values and strings in embedded application
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Stepper Motor Interfacing With Arduino UNO

STEPPER
MOTOR

e Rotate the Stepper Motor Clockwise and anti-clockwise by interfacing it with
Arduino. Here, we are using a ULN2003 driver which is used to drive a stepper
motor.

7-Segment Display Interfacing With Arduino UNO

e 7-segment LED displays are used for displaying numerical values from 0 to 9 and
few characters like A, b, C, d, e, F, H, L, O, P, U etc.7-segment displays are
widely used in digital clock
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Servo Motor Interfacing With Arduino Uno

e Servo motor is an electromechanical device which consists of motor, gear
assembly and feedback circuitry. It is used in Robotics applications, airplanes,
rudders, quad copters, etc.

TCP Client Using SIM900A GPRS and Arduino UNO

e Transmission Control Protocol (TCP) is standard transport layer internet protocol
in between server and client. Using SIM900A GPRS module, we can implement
TCP server/client over GPRS for 10T applications
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HTTP Client Using Sim900A GPRS And Arduino UNO

e Hypertext Transfer Protocol (HTTP) is standard application layer protocol in
between server and client. Using SIM900A GPRS module, we can implement
HTTP server/client over GPRS for loT applications

Soil Moisture Sensor Interfacing With Arduino UNO

e Soil moisture sensor is used to measure the water content (moisture) in the
soil. It is used in agriculture applications, irrigation and gardening systems,
etc.
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Thermistor Interfacing With Arduino UNO

e Thermistor is a type of resistor whose resistance changes in accordance with
change in temperature. It is used to measure the temperature over small range
typically -100 °C to 300 °C

Thermocouple Interfacing With Arduino UNO

e Thermocouple is a device consisting of two dissimilar metals connected
together creating a junction which is used for measuring the temperature
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Sim900A GSM Module Interfacing With Arduino UNO

SIMCOM

SIM900A

e SIM900A GSM module is a communication device which is used to make or
receive calls, send or receive SMS, connect to the internet over GPRS

ESP8266 WiFi Module Interfacing With Arduino UNO

e ESP8266 is Wi-Fi enabled system on chip (SoC) module developed by Espressif
system. It is mostly used for development of IoT (Internet of Things) embedded
applications.
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Nokia5110 Graphical Display Interfacing With Arduino UNO
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e Nokia5110 is 48x84 dot LCD display with Serial Peripheral Interface (SPI)
Connectivity. It was designed for cell phones, also used in embedded
applications

OLED Graphic Display Interfacing With Arduino UNO

e OLED graphic display modules are compact and have high contrast pixels which
make these displays easily readable. They do not require backlight since the
display creates its own light. Hence they consume less power. Both 12C and SPI
based OLED modules are available in market
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XBee S2 (ZigBee) Interfacing With Arduino UNO

e XBee is a radio module developed by Digi International. It is a popular
wireless transceiver used to send or receive data

NRF24L01 Interfacing With Arduino UNO

e nRF24L01 is ultra-low power RF transreceiver radio module for 204GHz ISM
band which is developed by Nordic Semiconductor.

MicroSD Card Interfacing With Arduino
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e MicroSD (Secure Digital) card is an electronic digital data storage device, which
provides storage in a gigabyte (GB) at low cost and small size. It is used in
various applications like Mobile Phones, Laptops, Digital Camera, etc.

Ultrasonic Sensor HC-SR04 Interfacing With Arduino Uno

HC-SR04

e Ultrasonic Sensor HC-SR04 interfaced with Arduino for finding a distance to an
object. It can operate in the range of2cm-400cm.

ARDUINO IDE

e The Arduino Integrated Development Environment - or Arduino Software (IDE) -
contains a text editor for writing code, a message area, a text console, a toolbar
with buttons for common functions and a series of menus. It connects to the
Arduino and Genuino hardware to upload programs and communicate with them.

1. Writing Sketches

e Programs written using Arduino Software (IDE) are called sketches. These
sketches are written in the text editor and are saved with the file extension .ino.
The editor has features for cutting/pasting and for searching/replacing text. The
message area gives feedback while saving and exporting and also displays
errors. The console displays text output by the Arduino Software (IDE), including
complete error messages and other information. The bottom right-hand corner of
the window displays the configured board and serial port. The toolbar buttons
allow you to verify and upload programs, create, open, and save sketches, and
open the serial monitor.

¢ NB: Versions of the Arduino Software (IDE) prior to 1.0 saved sketches with the
extension .pde. It is possible to open these files with version 1.0, you will be
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prompted to save the sketch with the .ino extension on save.
o Verify: Checks your code for errors compiling it.

o Upload: Compiles your code and uploads it to the configured
board. See uploading below for details.

o Note: If you are using an external programmer with your board, you can hold
down the "shift" key on your computer when using this icon. The text will
change to "Upload using Programmer"

o New: Creates a new sketch.

o Open: Presents a menu of all the sketches in your sketchbook. Clicking one
will open it within the current window overwriting its content.

o Note: due to a bug in Java, this menu doesn't scroll; if you need to open a
sketch late in the list, use the File | Sketchbook menu instead.

o Save: Saves your sketch.
o Serial: Monitor Opens the serial monitor.

Additional commands are found within the five menus: File, Edit, Sketch, Tools,
and Help. The menus are context sensitive, which means only those items
relevant to the work currently being carried out are available.

File

New: Creates a new instance of the editor, with the bare minimum structure of a
sketch already in place.

Open: Allows loading a sketch file browsing through the computer drives and
folders.

Open Recent: Provides a short list of the most recent sketches, ready to be
opened.

Sketchbook: Shows the current sketches within the sketchbook folder structure;
clicking on any name opens the corresponding sketch in a new editor instance.

Examples: Any example provided by the Arduino Software (IDE) or library
shows up in this menu item. All the examples are structured in a tree that allows
easy access by topic or library.

Close: Closes the instance of the Arduino Software from which it is clicked.

Save: Saves the sketch with the current name. If the file hasn't been named
before, a name will be provided in a "Save as.." window.

Save as: Allows saving the current sketch with a different name.
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Page Setup: It shows the Page Setup window for printing.

Print: Sends the current sketch to the printer according to the settings defined
in Page Setup.

Preferences: Opens the Preferences window where some settings of the
IDE maybe customized, as the language of the IDE interface.

Quit: Closes all IDE windows. The same sketches open when Quit was
chosen willbe automatically reopened the next time you start the IDE.

Edit

Undo/Redo: Goes back of one or more steps you did while editing; when you
go back, you may go forward with Redo.

Cut: Removes the selected text from the editor and places it into theclipboard.
Copy: Duplicates the selected text in the editor and places it into theclipboard.

Copy for Forum: Copies the code of your sketch to the clipboard in aform
suitable for posting to the forum, complete with syntax coloring.

Copy as HTML: Copies the code of your sketch to the clipboard as HTML,
suitable for embedding in web pages.

Paste: Puts the contents of the clipboard at the cursor position, in the editor.

Select All: Selects and highlights the whole content of the editor.

Comment/Uncomment: Puts or removes the // comment marker at the
beginning of each selected line.

Increase/Decrease Indent: Adds or subtracts a space at the beginning of each
selected line, moving the text one space on the right or eliminating a space at
the beginning.

Find: Opens the Find and Replace window where you can specify text to
searchinside the current sketch according to several options.

Find Next: Highlights the next occurrence - if any - of the string specified as
the search item in the Find window, relative to the cursor position.

Find Previous: Highlights the previous occurrence - if any - of the string
specified as the search item in the Find window relative to the cursor position.

. Sketch

Verify/Compile: Checks your sketch for errors compiling it; it will report memory
usage for code and variables in the console area.
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Upload: Compiles and loads the binary file onto the configured board through
the configured Port.

Upload Using Programmer: This will overwrite the boot loader on the board;
you will need to use Tools > Burn Boot loader to restore it and be able to Upload
to USB serial port again. However, it allows you to use the full capacity of the
Flash memory for your sketch. Please note that this command will NOT burn the
fuses. To do so Tools -> Burn Boot loader command must be executed.

Export Compiled Binary: Saves a .hex file that may be kept as archive or sent
to the board using other tools.

Show Sketch Folder: Opens the current sketch folder.

Include Library: Adds a library to your sketch by inserting #include statements
at the start of your code. For more details, see libraries below. Additionally, from
this menu item you can access the Library Manager and import new libraries
from .zip files.

Add File: Adds a source file to the sketch (it will be copied from its current
location). The new file appears in a new tab in the sketch window. Files can be
removed from the sketch using the tab menu accessible clicking on the small
triangle icon below the serial monitor one on the right side o the toolbar.

. Tools

Auto Format: This formats your code nicely: i.e. indents it so that opening and
closing curly braces line up, and that the statements inside curly braces are
indented more.

Archive Sketch: Archives a copy of the current sketch in .zip format. The
archive is placed in the same directory as the sketch.

Fix Encoding & Reload: Fixes possible discrepancies between the editor char
map encoding and other operating systems char maps.

Serial Monitor: Opens the serial monitor window and initiates the exchange of
data with any connected board on the currently selected Port. This usually resets
the board, if the board supports Reset over serial port opening.

Board: Select the board that you're using. See below for descriptions of the
various boards.

Port: This menu contains all the serial devices (real or virtual) on your machine.
It should automatically refresh every time you open the top-level tools menu.

Programmer: For selecting a hardware programmer when programming a board
or chip and not using the onboard USB-serial connection. Normally you won't
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need this, but if you're burning a boot loader to a new microcontroller, you will
use this.

Burn Boot loader: The items in this menu allow you to burn a boot loader onto
the microcontroller on an Arduino board. This is not required for normal use of an
Arduino or Genuino board but is useful if you purchase a new ATmega
microcontroller (which normally come without a boot loader). Ensure that you've
selected the correct board from the Boards menu before burning the boot loader
on the target board. This command also set the right fuses.

6. Help

Here you find easy access to a number of documents that come with the Arduino
Software (IDE). You have access to Getting Started, Reference, this guide to the
IDE and other documents locally, without an internet connection. The documents
are a local copy of the online ones and may link back to our online website.

Find in Reference: This is the only interactive function of the Help menu: it
directly selects the relevant page in the local copy of the Reference for the
function or command under the cursor.

Sketchbook

The Arduino Software (IDE) uses the concept of a sketchbook: a standard place
to store your programs (or sketches). The sketches in your sketchbook can be
opened from the File > Sketchbook menu or from the Open button on the
toolbar. The first time you run the Arduino software, it will automatically create a
directory for your sketchbook. You can view or change the location of the
sketchbook location from with the Preferences dialog.

Beginning with version 1.0, files are saved with an .ino file extension. Previous
versions use the .pde extension. You may still open .pde named files in version
1.0 and later, the software will automatically rename the extension to .ino.

Tabs, Multiple Files, and Compilation

Allows you to manage sketches with more than one file (each of which appears
in its own tab). These can be normal Arduino code files (no visible extension), C
files (.c extension), C++ files (.cpp), or header files (.h).

Uploading

Before uploading your sketch, you need to select the correct items from the Tools
> Board and Tools > Port menus. The boards are described below. On the Mac,
the serial port is probably something like /dev/tty.usbmodem241 (for a Uno or
Mega2560 or Leonardo) or /devi/tty.usbserial-1B1 (for a Duemilanove or
earlier USB board), or /dev/tty. USA19QW1b1P1.1 (for a serial board
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connected with a Keyspan USB-to- Serial adapter). On Windows, it's
probably COM1 or COM2 (for a serial board) or COM4, COM5, COM7, or
higher (for a USB board) - to find out, you look for USB serial device in the sports
section of the Windows Device Manager. On Linux, it should be

/dev/ttyACMx , /dev/ttyUSBx or similar. Once you've selected the correct serial
port and board, press the upload button in the toolbar or select the Upload
item from the Sketch menu. Current Arduino boards will reset automatically and
begin the upload. With older boards (pre-Diecimila) that lack auto-reset, you'l
need to press the reset button on the board just before starting the upload. On
most boards, you'll see the RX and TX LEDs blink as the sketch is uploaded. The
Arduino Software (IDE) will display a message when the upload is complete, or
show an error.

When you upload a sketch, you're using the Arduino boot loader, a small
program that has been loaded on to the microcontroller on your board. It allows
you to upload code without using any additional hardware. The boot loader is
active for a few seconds when the board resets; then it starts whichever sketch
was most recently uploaded to

the microcontroller. The boot loader will blink the on-board (pin 13) LED when it
starts (i.e. when the board resets).

Libraries

Libraries provide extra functionality for use in sketches, e.g. working with
hardware or manipulating data. To use a library in a sketch, select it from the
Sketch > Import Library menu. This will insert one or more #include statements
at the top of the sketch and compile the library with your sketch. Because
libraries are uploaded to the board with your sketch, they increase the amount of
space it takes up. If a sketch no longer needs a library, simply delete its #include
statements from the top of your code.

There is a list of libraries in the reference. Some libraries are included with the
Arduino software. Others can be downloaded from a variety of sources or
through the Library Manager. Starting with version 1.0.5 of the IDE, you do can
import a library from a zip file and use it in an open sketch.

Third-Party Hardware

Support for third-party hardware can be added to the hardware directory of your
sketchbook directory. Platforms installed there may include board definitions
(which appear in the board menu), core libraries, boot loaders, and programmer
definitions. To install, create the hardware directory, then unzip the third-party
platform into its own sub-directory. (Don't use "arduino" as the sub-directory
name or you'll override the built-in Arduino platform.) To uninstall, simply delete

its directory.
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Serial Monitor

e This displays serial sent from the Arduino or Genuino board over USB or serial
connector. To send data to the board, enter text and click on the "send" button or
press enter. Choose the baud rate from the drop-down menu that matches the
rate passed to Serial.begin in your sketch. Note that on Windows, Mac or Linux
the board will reset (it will rerun your sketch) when you connect with the serial
monitor. Please note that the Serial Monitor does not process control characters;
if your sketch needs a complete management of the serial communication with
control characters, you can use an external terminal program and connect it to
the COM port assigned to your Arduino board.

Preferences

e Some preferences can be set in the preferences dialog (found under the Arduino
menu on the Mac, or File on Windows and Linux). The rest can be found in the
preferences file, whose location is shown in the preference dialog.

Language Support

Sketchboaok focation

{Users/scott/Documents /Ardyuing firowse

Editor language:  System Default | (requires restart of Arduino)
Catald (Catalan)
Editor font size. | AP X (Chinese Simplified) Ino)

BEPX {Chinegse Traditional)
Show verbose oul

a

W Verify code aft Ne

gyar (Hungarian)

taliana (Ralian)
BE38 Japanese)
oK Cancel

Latviedu (Latvian)

e Since version 1.0.1 , the Arduino Software (IDE) has been translated into 30+
different languages. By default, the IDE loads in the language selected by your
operating system. (Note: on Windows and possibly Linux, this is determined by
the locale setting which controls currency and date formats, not by the language
the operating system is displayed in.)

e If you would like to change the language manually, start the Arduino Software
(IDE) and open the Preferences window. Next to the Editor Language there is a
dropdown menu of currently supported languages. Select your preferred
language from the menu, and restart the software to use the selected language.
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If your operating system language is not supported, the Arduino Software (IDE)
will default to English.

e You can return the software to its default setting of selecting its language based
on your operating system by selecting System Default from the Editor Language
drop-down. This setting will take effect when you restart the Arduino Software
(IDE). Similarly, after changing your operating system's settings, you must restart
the Arduino Software (IDE) to update it to the new default language.

Boards

e The board selection has two effects: it sets the parameters (e.g. CPU speed and
baud rate) used when compiling and uploading sketches; and sets and the file
and fuse settings used by the burn boot loader command. Some of the board
definitions differ only in the latter, so even if you've been uploading successfully
with a particular selection you'll want to check it before burning the boot loader.
You can find a comparison table between the various boards here.

e Arduino Software (IDE) includes the built in support for the boards in the
following list, all based on the AVR Core. The Boards Manager included in the
standard installation allows adding support for the growing number of new boards
based on different cores like Arduino Due, Arduino Zero, Edison, and Galileo and
SO on.

e Arduino Yun: An ATmega32u4 running at 16 MHz with auto-reset, 12 Analog In,
20 Digital I/O and 7 PWM.

e Arduino/Genuino Uno: An ATmega328P running at 16 MHz with auto-reset, 6
Analog In, 14 Digital I/O and 6 PWM.

e Arduino Diecimila or Duemilanove w/ ATmegal68: An ATmegal68 running
at 16 MHz with auto-reset.

e Arduino Nano w/ ATmega328P: An ATmega328P running at 16 MHz with
auto-reset. Has eight analog inputs.

e Arduino/Genuino Mega 2560: An ATmega2560 running at 16 MHz with auto-
reset, 16 Analog In, 54 Digital I/O and 15 PWM.

e Arduino Mega: An ATmegal280 running at 16 MHz with auto-reset, 16
Analog In, 54 Digital /0O and 15 PWM.

e Arduino Mega ADK: An ATmega2560 running at 16 MHz with auto-reset, 16
Analog In, 54 Digital /0 and 15 PWM.

e Arduino Leonardo: An ATmega32u4 running at 16 MHz with auto-reset, 12
Analog In, 20 Digital I/O and 7 PWM.
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Arduino/Genuino Micro: An ATmega32u4 running at 16 MHz with auto-reset,
12 Analog In, 20 Digital I/O and 7 PWM.

Arduino Esplora: An ATmega32u4 running at 16 MHz with auto-reset.

Arduino Mini w/ ATmega328P: An ATmega328P running at 16 MHz with auto-
reset, 8 Analog In, 14 Digital /0O and 6 PWM.

Arduino Ethernet: Equivalent to Arduino UNO with an Ethernet
shield: An ATmega328P running at 16 MHz with auto-reset, 6 Analog In, 14
Digital 1/0 and 6 PWM.

Arduino Fio: An ATmega328P running at 8 MHz with auto-reset. Equivalent to
Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ ATmega328P, 6 Analog In, 14 Digital
I/O and 6 PWM.

Arduino BT w/ ATmega328P: ATmega328P running at 16 MHz. The boot
loader burned (4 KB) includes codes to initialize the on-board Bluetooth module,
6 Analog In, 14 Digital I/O and 6 PWM..

LilyPad Arduino USB: An ATmega32u4 running at 8 MHz with auto-reset, 4
Analog In, 9 Digital /0O and 4 PWM.

LilyPad Arduino: An ATmegal68 or ATmegal32 running at 8 MHz with auto-
reset, 6 Analog In, 14 Digital /0O and 6 PWM.

Arduino Pro or Pro Mini (5V, 16 MHz) w/ ATmega328P: An ATmega328P
running at 16 MHz with auto-reset. Equivalent to Arduino Duemilanove or Nano
w/ ATmega328P; 6 Analog In, 14 Digital /0O and 6 PWM.

Arduino NG or older w/ ATmegal68: An ATmegal68 running at 16 MHz
without auto- reset. Compilation and upload is equivalent to Arduino Diecimila
or Duemilanove w/ ATmegal68, but the boot loader burned has a slower
timeout (and blinks the pin 13 LED three times on reset); 6 Analog In, 14 Digital
I/O and 6 PWM.

Arduino Robot Control: An ATmega328P running at 16 MHz with auto-reset.
Arduino Robot Motor: An ATmega328P running at 16 MHz with auto-reset.

Arduino Gemma: An ATtiny85 running at 8 MHz with auto-reset, 1 Analog In,
3 Digital I/0O and 2 PWM.

ARDUINO PROGRAMING

Arduino programs are written in the Arduino Integrated Development
Environment (IDE). Arduino IDE is special software running on your system that
allows you to write sketches (synonym for program in Arduino language) for
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different Arduino boards. The Arduino programming language is based on a very
simple hardware programming language called processing, which is similar to the
C language. After the sketch is written in the Arduino IDE, it should be uploaded
on the Arduino board for execution.

e The first step in programming the Arduino board is downloading and installing the
Arduino IDE. The open source Arduino IDE runs on Windows, Mac OS X, and
Linux. Download the Arduino software (depending on your OS) from the official
website and follow the instructions to install.

The basics of Arduino programming.

e The structure of Arduino program is pretty simple. Arduino programs have a
minimum of 2 blocks,

e Preparation & Execution

e Each block has a set of statements enclosed in curly braces:
void setup()

{

statements-1;

statement-n;

}
void loop ()

{

statement-1;

statement-n;

}

e Here, setup () is the preparation block and loop () is an execution block.

e The setup function is the first to execute when the program is executed, and this
function is called only once. The setup function is used to initialize the pin modes
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and start serial communication. This function has to be included even if there are
no statements to execute.

void setup ()

{

pinMode (pin-number, OUTPUT); // set the ‘pin-number’ as output
pinMode (pin-number, INPUT); // set the ‘pin-number’ as output

}

e After the setup () function is executed, the execution block runs next. The
execution block hosts statements like reading inputs, triggering outputs,
checking conditionsetc..

e In the above example loop () function is a part of execution block. As the name
suggests, the loop( ) function executes the set of statements (enclosed in curly
braces) repeatedly.

Void loop ()
{

digitalWrite (pin-number,HIGH); // turns ON the component connected to ‘pin-
number’

delay (1000); // wait for 1 sec

digitalWrite (pin-number, LOW); // turns OFF the component connected to ‘pin-
number’

delay (1000); //wait for 1sec
}

e Note: Arduino always measures the time duration in millisecond. Therefore,
whenever you mention the delay, keep it in milli seconds.

¢ Now, let’s take a giant leap and do some experiments with Arduino
1. Blinking the LED
2. Fade-in and fade-out the LED

e In the process of experimenting with Arduino, writing the Arduino programis
not the only important thing, building the breadboard circuit is equally
important.

o Let'stake alookathowthe breadboard circuit hasto be built for both theexperiments.

e Components required:
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o Arduino UNO R3 -1

o Breadboard -1

o Breadboard connectors -3
o LED-1

o 1K resistor -1

1. Blinking LED

Steps in building a breadboard connection:

Step-1: Connect the Arduino to the Windows / Mac / Linux system via a USB
cable

Step-2: Connect the 13th digital pin of Arduino to the positive power rail
of the breadboard and GND to the negative

Step-3: Connect the positive power rail to the terminal strip via a 1K ohmresistor
Step-4: Fix the LED to the ports below the resistor connection in the terminal strip

Step-5: Close the circuit by connecting the cathode (the short chord) of the
LED to the negative power strip of the breadboard

Arduino proaram for LED blink (Version-1

int LED =13; // The digital pin to which the LED is

connected void setup ()

{

pinMode (LED, OUTPUT); //Declaring pin 13 as output pin
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}

void loop() // The loop function runs again and again
{

digitalWrite (LED, HIGH); //Turn ON

the LED delay(1000); //Wait for 1sec

digitalRead (LED, LOW); // Turn off

the LED delay(1000); // Wait for 1sec

}

Arduino program for LED blink (Version-2)
void setup ()

{
pinMode (13, OUTPUT); //pin 13 is set as output pin

}

void loop() // The loop function runs again and again
{

digitalWrite (13,HIGH); // Turn ON the LED on

pin 13 delay (1000); //Wait for 1sec

digitalWrite (13, LOW); //Turn OFF the LED on pin 13

}

e In version-1 of the LED blink program LED is declared globally and is set to pin
number

13. This will reduce the number of iterations required to update the pin number in
the program when you connect the LED to the other digital pin. Whereas, the pin
number has to be changed in 3 different statements in version-2.
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The magic happens when you click the upload icon in the Arduino IDE. The
program will be uploaded into the microcontroller of Arduino board and LED in
the circuit starts blinking.

Blink | Arduloo 1.6.11

2. Fade-in and fade-out the LED

The step for the LED bling experiment are the same as those followed for
building the breadboard circuit except that in step-2, you connect the 9th digital
pin to the positive power rail of the breadboard.

Arduino program for LED fade-in and fade-out
(Version-1) int led = 9; // The digital pin to which the

LED is connected int brightness = 0; // Brightness

Page 61




of LED is initially set to 0 int fade = 5; // By how
many points the LED should fade void setup()

{
pinMode(led, OUTPUT); //pin 10 is set as output pin

}

void loop() // The loop function runs again and again

{

analogWrite(led, brightness); // set the brightness of LED
brightness = brightness + fade; //Increase the brightness of LED
by 5 points if (brightness <=0 || brightness >= 255) // check the

level of brightness

{

fade = -fade;

}

delay(30); // Wait for 30 milliseconds
}

Arduino program for LED fade-in and fade-out
(Version-2) int led=19; // The digital pin to which

the LED is connected void setup()

{
pinMode(led, OUTPUT); //pin 10 is set as output pin

}

void loop() // The loop function runs again and again

{

for (int fade=0; fade<=255; fade=fade+5)

{

analogWrite (led, fade); // Change the brightness of LED by
5 points delay (30);

}

}
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¢ In both the versions of the LED fade-in and fade-out programs, the analog Write
statement is used for a led connected to a digital pin. The reason for this is that,
digital pin 10 is a PWM pin. As discussed in the previous article, A tour of the
Arduino UNO board, a PWM pin is capable of generating Analog output. In both
the programs pin 10 is used as analog output pin.

VARIOUS REAL TIME APPLICATIONS OF IOT
Overview
e Understand the varied applications of the Internet of Things (1oT)

¢ Includes detailed study about smart homes, connected devices & many
other work areas

Introduction

e Do you know what separates humans from other living beings?
. Curiosity. Humans are curious. We question a lot. We are the ones who
challenge the status quo of existing rules and strive to build/produce something
better. Such curiosity & efforts have promised us a life where electronic devices &
machines will probably become our best friend.

e Yes, you read it correctly the vision to make machines smart enough to reduce
human labor to almost nil. The idea of inter-connected devices where the devices
are smart enough to share information with us, to cloud based applications and to
each other (device to device).

e Smartdevices or “Connected devices” as they are commonly called, are designed in
such a way that they capture and utilize every bit of data which you share or use
in everyday life. And these devices will use this data to interact with you on daily
basis and complete tasks.

1. Smart Home

e WithloT creating the buzz, ‘Smart Home’ is the most searched 0T associated feature on
Google. But, what is a Smart Home?

e Wouldn'’t you love if you could switch on air conditioning before reaching home or
switch off lights even after you have left home? Or unlock the doors to friends for
temporary access evenwhen you are notat home. Don’t be surprised with 10T taking
shape companies are building products to make your life simpler and convenient.

e Smart Home has become the revolutionary ladder of success in the residential
spaces and it is predicted Smart homes will become as common as smart
phones.
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e The costofowning ahouse isthe biggestexpense inahomeowner’s life. Smart Home
products are promised to save time, energy and money. With Smart home
companies like Nest, Ecobee, Ring and August, to name a few, will become
household brands and are planning to deliver a never seen before experience.

2. Wearable’s

e Wearables have experienced an explosive demand in markets all over the world.
Companies like Google, Samsung have invested heavily in building such
devices. But, how do they work?

e Wearable devices are installed with sensors and software’s which collect data and
information about the users. This data is later pre-processed to extract essential
insights about user.

e These devices broadly cover fitness, health and entertainment requirements. The
pre- requisite from internet of things technology for wearable applications is to be
highly energy efficient or ultra-low power and small sized.

3. Connected Cars

e The automotive digital technology has focused on optimizing vehicles internal
functions. But now, this attention is growing towards enhancing the in-car
experience.

e A connected car is a vehicle which is able to optimize its own operation,
maintenance as well as comfort of passengers using onboard sensors and
internet connectivity.

e Most large auto makers as well as some brave startups are working on
connected car solutions. Major brands like Tesla, BMW, Apple, and Google are
working on bringing the next revolution in automobiles.

4. Industrial Internet

e Industrial Internet is the new buzz in the industrial sector, also termed as
Industrial Internet of Things ( 1loT ). It is empowering industrial engineering with
sensors, software and big data analytics to create brilliant machines.

e Accordingto Jeff Immelt, CEO, GE Electric, lloT is a “beautiful, desirable and investable”
asset. The driving philosophy behind IlloT is that, smart machines are more
accurate and consistent than humans in communicating through data. And, this
data can help companies pick inefficiencies and problems sooner.

e |loT holds great potential for quality control and sustainability. Applications for
tracking goods, real time information exchange about inventory among suppliers
and retailers and automated delivery will increase the supply chain efficiency.
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According to GE the improvement industry productivity will generate $10 trillion to
$15 trillion in GDP worldwide over next 15 years.

Smart Cities

Smart city is another powerful application of IoT generating curiosity among world’s
population. Smart surveillance, automated transportation, smarter energy
management systems, water distribution, urban security and environmental
monitoring all are examples of internet of things applications for smatrt cities.

loT will solve major problems faced by the people living in cities like pollution,
traffic congestion and shortage of energy supplies etc. Products like cellular
communication enabled Smart Belly trash will send alerts to municipal services
when a bin needs to be emptied.

By installing sensors and using web applications, citizens can find free available
parking slots across the city. Also, the sensors can detect meter tampering
issues, general malfunctions and any installation issues in the electricity system.

loT in agriculture

With the continuous increase in world’s population, demand for food supply is
extremely raised. Governments are helping farmers to use advanced techniques
and research to increase food production. Smart farming is one of the fastest
growing fields in IoT.

Farmers are using meaningful insights from the data to yield better return on
investment. Sensing for soil moisture and nutrients, controlling water usage for
plant growth and determining custom fertilizer are some simple uses of loT.

Smart Retail

The potential of 10T in the retail sector is enormous. 10T provides an opportunity
to retailers to connect with the customers to enhance the in-storeexperience.

Smartphone’s will be the way for retailers to remain connected with their
consumers even out of store. Interacting through Smartphone’s and using Beacon
technology can help retailers serve their consumers better. They can also track
consumer’s path through a store and improve store layout and place premium
products in high traffic areas.

Energy Engagement

Power grids of the future will not only be smart enough but also highly reliable.
Smart grid concept is becoming very popular all over world.

The basic idea behind the smart grids is to collect data in an automated fashion
and analyze the behavior or electricity consumers and suppliers for improving
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efficiency as well as economics of electricity use.

e Smart Grids will also be able to detect sources of power outages more quickly
and at individual household levels like nearby solar panel, making possible
distributed energy system.

9. 10T in Healthcare

e Connected healthcare yet remains the sleeping giant of the Internet of Things
applications. The concept of connected healthcare system and smart medical
devices bears enormous potential not just for companies, but also for the well-
being of people in general.

e Research shows IoT in healthcare will be massive in coming years. IoT in
healthcare is aimed at empowering people to live healthier life by wearing
connected devices.

e The collected data will help in personalized analysis of an individual’s health and provide
tailor made strategies to combat illness. The video below explains how loT can
revolutionize treatment and medical help.

10.10T in Poultry and Farming

e Livestock monitoring is about animal husbandry and cost saving. Using loT
applications to gather data about the health and well being of the cattle, ranchers
knowing early about the sick animal can pull out and help prevent large number
of sick cattle.

e With the help of the collected data and ranchers can increase the poultry
production. Watch this interesting video.

CONNECTING IOT TO CLOUD

e The Internet of Things (IoT) will continue to transform the business landscape as
well as the way we live. Cloud computing is the backbone of this transformation.
Increased cloud adoption has acted as a springboard for many loT applications and
business models, offering the ability for companies to reduce time-to-market and
total cost of ownership.

Cloud and Connectivity Synergy for Enterprise loT

e Cloud computing allows companies to store and manage data over cloud
platforms, providing scalability in the delivery of applications and Software as a
Service (SaaS). IoT devices can generate a significant amount of data per
second, with Cisco estimating that IoT will generate 847 zettabytes per year by
2021.

e loT devices are often sensors that collect data and send it to be processed. In
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the domain of 10T, physical sensors are virtualized before the data is uploaded to
the cloud. While 10T devices can generate lots of data, cloud computing paves
the way for this data to travel. This data enables better workflow for developers,
who can store and access data remotely, which allows them to implement
projects withoutdelay.

Cloud computing enables the storage and analysis of data to be done quickly and
in real- time, allowing enterprises to get the maximum benefit. This is supported
by an industry survey from InformationWeek where 65% of respondents said "the
ability to quickly meet business demands" was one of the most important reasons
a business should move to a cloud environment.

With cloud computing, organizations do not have to deploy extensive hardware or
configure and manage networks and infrastructure. Cloud computing also
enables enterprises to scale up the infrastructure, depending on their needs,
without setting up additional hardware and infrastructure. This not only helps
speed up the development

process but can also cut down on development costs. Half of all CIOs and IT
leaders surveyed by the cloud-security company Bitglass, reported cost savings
from using cloud-based applications.

Devices are connected to the cloud through many different methods depending
on the device connectivity capabilities. These methods include cellular, satellite,
Wi-Fi, Low Power Wide Area Networks (LPWAN) (e.g. NB-loT), and direct
connection to the Internet via Ethernet. Cellular connectivity offers an excellent
choice for uninterrupted data transfer between devices, applications, and the
cloud.

Cellular Connectivity: The Reliable and Secure Choice for IoT Projects

Cellular technologies have been designed for reliability, security, and scalability.
Cellular Internet of Things (CloT), based on 3GPP standards, utilizes existing
infrastructure to provide excellent IoT coverage and a fast time-to-market.

Cellular 10T projects will include everything from devices, to a dedicated SIM card
and management platform. CloT hardware is always equipped with SIM cards
and can connect to networks via 2G, 3G, or LTE connectivity, depending on
which cell towers are available in different regions. For example, 2G switch-off
has already begun in many parts of the world, as detailed on our previous blog

post.

Cellular benefits include:

Coverage: Cellular data coverage today is extensive and growing and has the
added benefit of reaching underground spaces, buildings, and rural
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environments.

Security: End-to-end security is supported and aided by the SIM credentials.
This keeps data secure from the device to the cloud.

Bandwidth: Cellular technologies based on 4G LTE are now as fast as 1 Gbps,
with 5G expected to have speeds of up to 10 Gbps.

For example, fleet tracking relies on secure coverage across boundaries with no
risk of losing connection. To ensure this doesn’t happen, cellular connectivity is
better equipped than alternative connectivity methods, e.g. NB-loT is designed
for low throughput devices where a delay in communications will not hinder the
service. In fleet management, with vehicles driving across borders, it's essential
to have a robust and constant connection so that devices can be tracked in real
time.

EMnify — Bringing the Cloud and Cellular Connectivity Together

L EMnify is an 10T connectivity provider that enables cellular IoT products
and services worldwide. The company serves the growing needs of developers
and enterprises that require secure, global connectivity for IoT/M2M applications.
Its multi-network EMnify SIM can operate instantly in over 180 countries across 540
mobile networks.

EMnify connected devices benefit from a purpose-built and fully virtualized
mobile core network that enables features like virtual private device cloud and
dynamic regional internet breakouts. The EMnify management platform gives an
oversight of 0T device connectivity as well as access to analytics with an
easy to use and intuitive Ul. The EMnify SIM is multi-carrier meaning it will
automatically connect to the best cellular network and ensure the connection
remains stable and continuously connected all around the world.

In August 2018, EMnify achieved the AWS IoT Competency which differentiates
EMnify as an AWS Partner Network (APN) member that has demonstrated
relevant technical proficiency and proven customer success delivering solutions
seamlessly in the AWS Cloud environment. Learn more about the successful
transition to a Cloud Mobile Network and its benefits in the EMnify case study
prepared for Telecom Liechtenstein.
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CLOUD STORAGE FOR IOT
1. Thingworx 8 IoT Platform

e Thingworx is one of the leading loT platforms for industrial companies, which
provides easy connectivity for devices. It enables the experience from today’s
connected world. Thingworx 8 is a better, faster, easier platform, providing the
functionality to build, deploy, and extend industrial projects and apps.

Applications & Solutions
Powered by ThingWorx

SREDVERCHAARE

P'OEC‘ZS:‘ : ASWG Do Benchmarking
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Extensions
ThingServer
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e Thingworx is an IoT platform designed by PTC for development of enterprise app
development. It offers basic features, such as:

o Easy connectivity with electronic devices, like sensors and RFIDs

o You can work remotely once you are done with the setup
o Pre-built widgets for the dashboard

o Remove Complexity of the project
o Integrated machine learning
e Pros
o Easy web page designs for customers
o Easy to manage devices
o Simple connectivity solutions
e Cons
o Difficult to use with custom programs in C#
o Hard to manage complex systems.

o The limitation to install edge program on a custom platform.
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2. Microsoft Azure loT Suite

Microsoft Azure provides multiple services to create IoT solutions. It enhances
your profitability and productivity with pre-built connected solutions. It analyzes
untapped data to transform business. This provides the solutions for a small PoC
to Rolling out your ideas. Azure Suite can easily analyze and act on new data.

Microsoft Azure loT Suite

Accelerate your business transformation

Azure loT Suite

d more

Azure loT Suite provides features like:

o Easy Device Registry.
o Rich Integration with SAP, Salesforce, Oracle, WebSphere, etc

o Dashboards and visualization

o Real-time streaming

Pros

o Offers third-party services
o Secure and scalable

o High availability

Cons

o Requires management

o Expensive

o No support for bugs

3. Google Cloud’s 10T Platform

Google's platform is among the best platforms we currently have. Google has an
end-to- end platform for Internet-of-Things solutions. It allows you to easily
connect, store, and manage loT data. This platform helps you to scale your
business.
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e Their main focus is on making things easy and fast. Pricing on Google Cloud is
done on a per-minute basis, which is cheaper than other platforms.

e Google Cloud's 10T platform provides features, including:

o Provides huge storage
o Cuts cost for server maintenance
o Business through a fully protected, intelligent, and responsive 10T data
o Efficient and scalable
o Analyze big data
e Pros
o Fastest input/output
o Lesser access time
o Provides integration with other Google services
e Cons
o Most of the components are Google technologies

o Limited programming language choices

4. |IBM Watson loT Platform

e |IBM Watson is a powerful platform backed by IBM ’s the Bluemix and hybrid
cloud PaaS (platform as a service) development platform. By providing easy
sample apps and interfaces for 0T services, they make it accessible to
beginners. You can easily try out their sample to see how it works, which makes

A cognitive loT will

transtorm antire industries

IBM Watson loT

#WatsonioT

it stand out from otherplatforms.

Page 71



https://cloud.google.com/solutions/iot/
https://www.ibm.com/internet-of-things/spotlight/watson-iot-platform
https://en.wikipedia.org/wiki/Bluemix
https://en.wikipedia.org/wiki/Platform_as_a_service

e Users can get the following features:
o Real-time data exchange
o Secure Communication
o Cognitive systems
o Recently added data sensor and weather data service
e Pros
o Process untapped data
o Handle huge quantities of data
o Improve customer services
e Cons
o Need a lot of maintenance.
o Take time for Watson integration
o High switching cost.

5. AWS loT Platform

e Amazon made it much easier for developers to collect data from sensors and
Internet- connected devices. They help you collect and send data to the cloud
and analyze that information to provide the ability to manage devices.

e You can easily interact with your application with the devices even they are offline.

Intermittent connection AWS loT REST APIs Output

e Main features of the AWS IloT platform are:

o Device management
o Secure gateway for devices
o Authentication and encryption
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o Device shadow

Pros

o Good integration with laas offering.
o Price dropped over the last six years
o Open and flexible

Cons

o A big learning curve for AWS

o Three outages in the last 2 years

o Not secure for hosting critical enterprise applications

6. Cisco IoT Cloud Connect
o Cisco Internet of Things accelerates digital transformation and
actions from your data. Cisco IoT Cloud Connect is a mobile, cloud-

v

Cisco Connect Cloud

based suite. It offers solutions for mobile operators to provide
phenomenal 0T experience. It provides flexible deployment options for your
devices.

The main feature of the Cisco Cloud Connect:
o Data and voice connectivity

o Device and IP session report

o Billing is customizable

o Flexible deployment options
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7. Salesforce loT Cloud

e Salesforce 10T Cloud is powered by Salesforce Thunder. It gathers data from
devices, websites, applications, and partners to trigger actions for real-time
responses. Salesforce combined with I0T delivers improved customer service.

ey [ol cloud

e Key features of Salesforce IoT Cloud:

o Enhanced data collection

Improved customer engagement

o

o Real-time event processing
o Technology optimization
e Pros
o Scale to billions of devices and messages.
o Easy Ul designs to connect with customers.
e Cons
o Security liability
o Flexibility limitations
8. KaaloT Platform

e Kaa is an open-source, multipurpose, middleware platform for complete end-to-
end loT development and smart devices. It reduces cost, risk, and market time.
Also, Kaa offers a range of 10T tools that can be easily plugged in and
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9. Oracle 0T Platform

implemented in 10T use cases.

It provides many features that make it unique, such as:

o

O

o

O

©)

o Ease of use
o Third-party integration
o Data security

Reduce development time
Open source and free

Easy and direct device implementation

Reduce marketing time

Handle millions of devices
Pros

Cons

o Not able to deploy applications based on the PaaS model

Oracle offers real-time Internet of Things data analysis, endpoint management,
and high speed messaging where the user can get real-time notification directly
on their devices. Oracle 10T cloud service is a Platform as a Service (PaaS),
cloud-based offering that helps you to make critical business decisions.

Oracle loT Cloud Service
Client Software

Features offering to users

o Secure and scalable

o Real-time insight

o

o Faster to market

Integrated

Pros

Oracle loT Cloud Service

R
Oevice = Event Store
Virtualization

EBE - - o

Meh Speed
Atessaging

Stresm Procecsing

. >
Endpoin Enterpsise
Management - Comnectvity

Oracle
Services

Enterprise

Apps
owd or On Premibse
L 3~ party
ape
) £
Sorvce | ndmey
g et aman pes
>
=
R -
Trarigortanon Asve! Mgt

Page 75



https://docs.oracle.com/en/cloud/paas/iot-cloud/index.html

o Device visualization
o High speed messaging

o Event store

10. Thingspeak loT Platform

Thingspeak is an open-source platform that allows you to collect and store
sensordata to the cloud. It provides you the app to analyze and visualize your
data in Matlab. You can use Arduino, Raspberry Pi, and Beaglebone to send
sensor data. You can create a separate channel to store data.

ThingSpeak App Platform

[:rh.nqspo ak welo services
‘mec_,s s ’ 3 pps
oﬂ\er things

Features of Thingspeak:

o Collect data in private channels

o App integration

o Event scheduling

o MATLAB analytics and visualization

Pros

o Free hosting for channels

o Easy visualization

o Provides additional features for Ruby, Node.js, and Python
Cons

o Limited data uploading for API

o ThingSpeak API can be a hurdle for beginners
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11. GE Predix 10T Platform

Predix is the world’s first industrial platform. Predix was designed to target factories
and provides simple ecosystem. It can directly analyze data from the machine
and store. GE wants to provide the growing industrial Internet of Things for its
cloud platform. This platform is secure and scalable.
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smarter together. v

My rachine. Any vendoc, Any vintage.

According to the customers their 10T platform can:
o Optimize assets and operations

o Provides key performance data

o Reduces unplanned downtime

o Real-time operational data

DATA ANALYTICS FOR IOT

Internet of things (loT) (»

Data analytic

»

Sensors data Data analytics Data monitoring
from loT device applications

Data source: fingent.com—Role of data analytics in internet of things (IoT), 2018
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Simply put, 0T data analytics is the analysis of huge data volumes generated by
connected devices. Organizations can derive a number of benefits from it:
optimize operations, control processes automatically, engage more customers,
and empower employees. The combination of IoT and data analytics has already
proven to be beneficial in retail, healthcare, telematics, manufacturing, and smart
cities. However, its true value for organizations has yet to be fully realized.

At least a decade ago, it was exceedingly difficult and expensive to analyze
massive volumes of information provided by a variety of connected devices. As
time goes on, the cost to store data is going down, and analytics capabilities are
making huge leaps forward. This creates favorable conditions for organizations to
start investing in and implementing 10T data analytics.

As the accessibility of 0T data analytics grows, more and more organizations are
seeing the benefits of having it. Widely-known companies such as Microsoft, GE,
Amazon, SAP, and Salesforce have already started implementing loT data
analytics into their day-to- day processes.

The value of 10T data for organizations

A huge variety of devices connect to the internet and share data through sensors
every day. This data is worthless without analysis. However, with an I0T analytics
solution put in place, the data that organizations produce is effectively collected,
analyzed, and stored. As a result, it allows organizations to optimize their
operations at all levels, improve decision making, and achieve a number of
benefits.

Better human productivity

Some organizations install smart sensors throughout their facilities to collect data
on employee engagement, performance ratings, and other work-related activities.
This data is later used to improve day-to-day business operations and help utilize
employee time and energy more efficiently.

As an example, Humanyze has developed a system that uses smart employee
badges with sensors that capture more than 100 data points to measure the
productivity of workers. It analyzes how people interact, how much they gesture
or listen, and what their tone of voice is. At one point, this data helped discover
that bringing call-center workers together for lunch at the same time instead of
staggering them so that somebody is always available to answer the phone,
significantly improved productivity due to:

o Job stress level decreased by 19%
o Productivity increased by 23%
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o Retention rate increased by 28%

If IoT data analytics is evaluated and implemented properly, it can have a
positive impact on employees’ productivity and overall business success. However,
thereis a privacy concern: Accenture reports that only 32% of employees consent
to their company using their workplace data, and 55% of businesses don’t ask for
consent.

Improved Equipment Maintenance

The combination of loT sensors and data analytics may help companies,
especially in the manufacturing industry, to determine when equipment requires
maintenance by measuring vibration, heat, and other important figures. Smart
equipment can also send messages to operators about potential breakdowns,
wear, and delivery schedules. This not only facilitates regular equipment
maintenance but also contributes to predictive maintenance.

Sensor data is used to predict when assets need to be serviced, which allows
maintenance to be scheduled at the optimal time, thus reducing breakdowns and
saving maintenance costs.

loT allows workers to see exactly how their machines are performing in real-time,
and alerts them to any issues that might be arising. Being able to prevent
unscheduled downtime by using predictive maintenance can provide significant
benefits. According to PwC’s Predictive Maintenance 4.0 study, utilizing predictive
maintenance can reduce costs by 12%, improve uptime by 9%, and reduce
safety, health, environment, and quality risks by 14% on average. Additionally, it
can extend the lifetime of an aging asset by 20%.

Operations optimization and automation

With loT and analytics working in tandem, organizations can automatically
control processes that previously could only be tracked manually. For example, it
gives manufacturers a comprehensive view of what's going on at every point in
production. This allows them to maintain a continuous flow of final products,
identify bottlenecks in real-time, and avoid defects. It also reduces the risk of
human error.

General Motors, for instance, monitors humidity with 10T sensors to optimize
painting. When conditions for painting are unfavorable, they send the detail to
another place with more appropriate humidity levels, thereby reducing downtime
and the need for repainting.

When another major manufacturing company, Bosch Rexroth, started utilizing
loT, they saw _a significant increase in productivity of both workers and
equipment.
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Enhanced customer experience

Be it a retail shop or a healthcare center, each organization strives to create a
better and more personalized customer experience. The implementation of 10T
data analytics can help with this onerous task. loT data reveals a wealth of
customer behaviors and preferences that can be analyzed and used to predict
customer needs.

For example, when a customer enters a store, the 10T data analytics system can
guide the shopper to the jeans they have been looking at online. It can also send
them a personalized coupon to make the purchase in-store that day. In addition,
retailers, restaurant chains, and makers of consumer goods can use I0T data to
do targeted marketing and promotions.

In healthcare, hospitals can use real-time 10T data analytics to manage increased
patient traffic and improve general operational efficiency.

This is beneficial to both parties; consumers gain more value through
convenience and time saving, while organizations increase their revenue and
stay more attractive to customers.

Challenges and barriers

What are the most significant barriers limiting your o
adoption of loT/analytics solutions?

Percentage of respondents Change since 2016
Security

IT/OT integration

Unclear ROI

Technical expertise

Interoperabllity T
Data portability T
Vendor risk T
Transgition risk

Legal/regulatory issues 4

Network constraints

Vendor lock-In 4

Data source: Bain |0T customer survey, 2016 [(n=533); Bain |oT customer survey, 2018 (n=627); market
participant interviews
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loT data analytics can certainly provide benefits in many business areas, like
reducing maintenance costs, avoiding equipment failures, and improving
customer experiences and human productivity. But despite the proven benefits of
applying loT data, many organizations don’t derive value from their data assets
simply because they don’t know what to do with the technology.

Also, sometimes employees get overwhelmed with the amount of data coming in,
preventing them from sifting through it all and finding efficient ways of utilizing it.
With multiple sensors providing information as frequently as every 30 seconds, it
could result in data overload for the workers or the computers, if the right ones aren’t
beingused.

Other possible barriers to 10T data analytics adoption include security issues and
high costs. Since it requires multiple machines and devices working together and
exchanging information, if one system is subjected to a security breach, it could
spread throughout all systems.

Additionally, because 0T data analytics is still fairly new, the implementation
costs can be high. This can deter business owners from adopting it, especially if
it is difficult to see the long-term benefits of making that investment.

loT data analytics on the rise, still

At a time when organizations are looking to gain a competitive edge, many are
starting to look toward the internet of things. It offers an opportunity to gather
even more information than before, which can improve processes, drive
innovation, and enhance customer experience. While it hasn’t reached every
corner of business and operations yet, it is already being used to make
workplaces safer and more efficient.

Having the ability to receive diagnostic and predictive data in real-time can be a
game- changer, especially for companies who rely heavily on their equipment
working properly and at full capacity. IoT data analytics allows workers to
schedule downtimes that are convenient or know exactly what is wrong without
having to bring in a technician to examine the machine. That all adds up to a less
expensive and more efficientoperation.

loT data analytics can also be used to make customers happier and enhance
their shopping experiences. By gathering data on the preferences of their
audiences, companies can give customers what they are looking for and even
know how much they are willing to pay for it. It can also gather useful data from
product reviews, giving companies a better idea of what their customers are
looking for or would like to see done differently.

o Even though there are still significant challenges to overcome, loT data
analytics continues to grow and gain popularity. It has the ability to offer
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unprecedented insights that have never before been so readily available. It is
reasonable to think that we will see a time in the near future where the general
consensus is that its pros outweigh its cons.

SOFTWARE & MANAGEMENT TOOLS FOR IOT

e |0T platforms and tools are considered as the most significant component of
the IoT ecosystem. Any loT device permits to connect to other 10T devices and
applications to pass on information using standard Internet protocols. 10T
platforms fill the gap between the device sensors and data networks. 10T
platforms connect the data to the sensor system and give insights using back-
end applications to create a sense of the plenty of data developed by the many
sensors.

e The Internet of Things (IoT) is the future of technology that helps the Atrtificial
intelligence (Al) to regulate and understand the things in a considerably
strongerway.

e We have picked up a mix of best known IoT platforms and tools that help you
todevelop the 10T projects in an organized way.

1. Zetta

o1

Zetta,js

IoT API-First Platform

e Zetta is APl based IoT platform based on Node.js. It is considered as a complete
toolkit to make HTTP APIs for devices. Zetta combines REST APIs, Web Sockets
to make data- intensive and real-time applications. The following are some
notable features.

o It can run on the cloud, or a PC, or even modest development boards.

o Easy interface and necessary programming to control sensors,
actuators, and controllers.

o Allows developers to assemble Smartphone apps, device apps, and cloud
apps.

o lItis developed for data-intensive and real-time applications.
o Turns any machine into an API.
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2. Arduino

ARDUINO

If you are seeking to make a computer that can perceive and exercise stronger
control over the real world when related to your ordinary stand-alone
computer, then Arduino can be your wise preference.

Offering an appropriate blend of 10T hardware and software, Arduino is a simple-
to-use IoT platform. It operates through an array of hardware specifications that
can be given to interactive electronics. The software of Arduino comes in the plan
of the Arduino programming language and Integrated Development Environment
(IDE).

3. Node-RED

Flutter

L

Node-RED

Node-RED is a visual tool for lining the Internet of Things, i.e., wiring together
hardware devices, APIs, and online services in new ways. Built on Node.js,
Node-RED describes itself as “a visual means for wiring the Internet of Things.”

It provides developers to connect devices, services, and APIs using a browser-
based flow editor. It can run on Raspberry Pi, and further 60,000 modules are
accessible to increase its facilities.

Flutter is a programmable processor core for electronics projects, designed for
students, and engineers. Flutter'stake to gloryisitslong-range. This Arduino-based board
includes a wireless transmitter that can show up to more than a half-mile. Plus, you don’t

g Flutter
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require a router; flutter boards can interact with each other quickly.

It consists of 256-bit AES encryption, and it’s simple to use. Some of the other features are

below.

e}

e}

O

e}

Fast Performance
Expressive and Flexible Ul
Native Performance

Visual finish and functionality of existing widgets.

4. M2MLabs Mainspring

M2mIE3 Sensor Simulation

Welcome admin

[y [ISRSI.
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e M2MLabs Mainspring is an application framework for developing a machine
to machines (M2M) applications such as remote control, fleet administration,
or smart terminal. Its facilities include flexible design of devices, device
structure, connection between machines and applications, validation and
normalization of data, long-term data repository, and data retrieval functions.

It'sbasedonJavaandthe Apache CassandraNoSQLdatabase. M2Mapplicationscanbe
modeled in hours rather than weeks and subsequently passed on to a high-
performance execution environment made on top of a standard J2EE server and

the highly-scalable Apache Cassandra database.
5. ThingsBoard

£

ThingsBoard

ThingsBoard is for data collection, processing, visualization, and device management. It
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upholds all standard IoT protocols like CoAP, MQTT, and HTTP as quickly as cloud and
on-premise deployments. It builds workflows based on design life cycle events, REST
API events, RPC requests.

Let’s take a look at the following ThigsBoard features.

o A stable platform that is combining scalability, production, and fault-tolerance.
o Easy control of all connected devices in an exceptionally secure system

o Transforms and normalizes device inputs and facilitates alarms for
generating alerts on all telemetry events, restores, and inactivity.

o Enables use-state specific features using customizable rule groups.
o Handles millions of devices at the same time.

o No single moment of failure, as every node in the bundle is exact.

o Multi-tenant installations out-of-the-wrap.

o Thirty highly customized dashboard widgets for successful user access.

6. Kinoma

Kinoma

Kinoma, a Marvell Semiconductor hardware prototyping platform, involves three
different open source projects. Kimona Create is a DIY construction kit for
prototyping electronic devices. Kimona Studio is the development environment
that functions with Set up and the Kinoma Platform Runtime. Kimona Connect is
a free i0OS and Android app that links smart phones and stands with 10T devices.
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7. Kaa loT Platform

Kaa is a production-ready, flexible, multi-purpose middleware platform for
establishing end-to-end 10T solutions, connected applications, and smart
devices. It gives a comprehensive way of carrying out effective communication,
deals with, and interoperation capabilities in connected and intelligent devices.

It mounts from tiny startups to a great enterprise and holds advanced deployment
models for multi-cloud IoT solutions. It is primarily based on flexible micro
services and readily conforms to virtually any need and application — some other
features asbelow.

o

O

O

Facilitates cross-device interoperability.
Performs real-time device control, remote device provisioning, and structure.
Create cloud services for smart products

Consists of topic-based warning systems to provide end-users to deliver
messages of any predefined format to subscribed endpoints.

Perform real-time device monitoring
Manage an infinite quantity of connected devices

Collect and analyze sensor data
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8. Site Where

-_

¢ SiteWhere

Instance Adminigtration

e Site Where platform offers the ingestion, repository, processing, and assimilation
of device inputs. It runs on Apache Tomcat and provides highly tuned MongoDB
and HBase implementations. You can deploy Site Where to cloud platforms like
AWS, Azure, GCP, or on-premises. It also supports Kubernetes cluster
provisioning.

e The following are some of the other features.

O

O

o

Run any estimate of 10T applications on a single Site Where instance
Spring brings the root configuration framework

Add widgets through self-registration, REST services, or in batches
InfluxDB for event data storage

Connect devices with MQTT, Stomp, AMQP and other protocols
Integrates third-party integration frameworks

Eclipse Californium for CoAP messaging

HBase for the non-relational datastore

Grafana to visualize Site Where data
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e Distributed Services Architecture (DSA) is for implementing inter-device
communication, logic, and efforts at every turn of the loT infrastructure. It allows
cooperation between devices in a distributed manner and sets up a network
engineer to share functionality between discrete computing systems.

e You can manage node attributes, permission, and links from DSLinks.
10. Thinger

e Thinger.io provides a scalable cloud base for connecting devices. You can deal
with them quickly by running the admin console or combine them into your
project logic using their REST API. It supports all types of hacker’s boards such as
Raspberry Pi, Intel Edison, and ESP8266.

e Thinger can be integrated with IFTT, and it provides real-time data on a beautiful
dashboard.
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